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1. Purpose and target audience of the AO Faculty Compendium 
Educating its members is crucial in the AO Foundation's approach to improve patient care 
worldwide. Having faculty who teach the AO Principles to future generations is just as important 
for building a network of educators. Therefore, training faculty how to teach is essential in 
delivering AO's message. To date more than 5'000 faculty members are teaching at AO's 
educational events worldwide. This compendium is designed to aid their tasks and goals.  
 
The AO Faculty Compendium is a publishing project under the lead of the Faculty Development 
Department of the AO Education Institute in Dübendorf, Switzerland. The AO Faculty 
Compendium will be an online hub where all resources used for the AO Faculty 
Development Programs will be stored. Its aim is to offer all faculty AO members  (no matter 
what Clinical Division they belong to) an easily accessible online platform where they can find 
and retrieve all documents relevant for their development as teachers in the AO. The content 
will cover the most important principles and concepts of Medical Education used in the AO as 
well as checklists, guidelines, and templates for the different educational roles (eg, table 
instructor, chairperson, coach etc.). The AO Faculty Compendium will be developed gradually, 
meaning that not all the content will be available right from the beginning. 
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2. Roles and responsibilities 

2.1 Author  
• Preparing the module according to all given instructions and within the timeframe defined 

in the agreement. Writing a new text requires indicating sources of illustrations, taking 
care that no copyright problems arise (see 3.7 "Letters of copyright permission"). 

• Ensuring that contents of the module are correct, up-to-date, and written in close 
cooperation with all assigned authors of the module. The first named author (see module 
briefings) is the person to contact his co-author(s) and discuss the workflow between the 
authors.  
 Do not work with other authors apart from the assigned ones. Change in authorship 

must be discussed with the editors first.  
 The first named author in the module briefing will be named first as module author. 

• Contacting authors of related modules to avoid duplications and wrong cross-referencing. 
• Providing additional information and implementing changes if requested by the module 

Editor. 
 Please note: Editors and AO edit manuscripts; the Editors have the final decision as 

to content, figures, and wording, especially in situations of contradiction. 
• Informing the module Editor and the Project Coordinator from AO Education about any 

change in the contact details. 
(see also Exhibit 1―General Terms for AO Foundation Editors/Authors) 

2.2 Editor  
• Defining the concept and purpose of the AO Faculty Compendium, table of contents, and 

detailed briefings (module, video, animation). 
• Contents: correctness, (medical) accuracy, consistency, international relevance, and up-

to-dateness of the contents.  
• Selecting (and, if necessary, excluding) authors, additional editors, reviewers, who are 

qualified to provide the defined content. 
• Procuring all manuscripts from authors; detailed quality checks, editing, including cross-

module editing. Final decision on contents, ensuring that the concept has been heeded. 
• Solving questions with authors and providing detailed instructions for revision of a 

manuscript if revision is needed. 
• Procuring and keeping all original letters of permission from the authors and taking care 

of correct credit lines. 
• Keeping to schedule and workflow. Informing the Project Coordinator regularly about the 

ongoing process (status). Giving early notice of tendencies that might prolong the 
process. 

• Approval of all assigned modules, videos, and illustrations. 
• Reading/approval of the entire publication in typesetting version (proof). 
• First contact person for the Project Coordinator. 

(see also Exhibit 1―General Terms for AO Foundation Editors/Authors) 
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2.3 Project Coordinator (AO Education) 
• Administration of the complete project. 
• Developing overall project plan in collaboration with the editors. 
• Preparing/providing guidelines and general information to authors and editors. 
• Establishing, coordinating, and supervising the publishing workflow and production 

process (editing, illustrating, typesetting, proofreading, indexing, print preparation, etc).  
 Coordinating the editing and review process of the manuscripts, incl. language 

editing, adherence to AO style and terminology. 
 Appointing tasks and allocating work to the people involved (incl. editors, authors, 

video team, illustrators, typesetters, language editors, etc).  
 Giving the green light to any process or stop it respectively. 
 Decision on AO Faculty Compendium layout, including cover etc. 

• Keeping an overview and status of the whole project. Informing the editors regularly 
about the status of the project. Giving early advice to prevent major problems. Informing 
editors about problems and consequences that might arise/have arisen from 
manuscripts, the process, or authorship. 

• Act and react in a way that ensures the overall plan and schedule is adhered to, thereby 
ensuring the quality of the product. 

• First contact person for editors. 

2.4 Working with your editor 
The author writes his/her module according to the module briefing and further documentation 
attached. If a module has several authors, the first named author (see module briefings) 
organizes the collaboration and submits the final manuscript to the module editor. 
 
The author emails the final manuscript (with associated files) to the Module Editor (as stated on 
the module briefing) and copies the Project Coordinator (Tatjana Topalovic, 
tatjana.topalovic@aofoundation.org) in on this message. Please do only hand over manuscripts 
that are complete and prepared according to the instructions. The author keeps a copy of all 
documents that are passed on to the editor.  
 
Please note the deadline for submissions is September 1, 2016. 
 

• In order to avoid later confusion, stop working on any part of the manuscript once you 
have passed it on to the module editor or anybody else who intends to work on it.  

 
The module editor can either make major changes himself or send the module back to the 
author(s) with instructions. The author(s) will then work on the module and subsequently provide 
the editor with a revised module:  
 

• Use track changes in Word documents to allow identification of corrections and their 
origin. Please see chapter 5 "Using Track Changes in Microsoft Word". 

• Save and rename files anew before working on them, thereby keeping the previous 
version as it is.  
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• It’s important to always work on the most recent manuscript version.  
• Do not delete old files; you might need them later or in case of data loss. 

 
The edited module will then be sent to AO Education for language and style editing. The author 
will receive the finally edited version of the manuscript for approval. 
 
As one missing part of the AO Faculty Compendium can hold up the whole production process, 
please adhere to our schedule!  
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3. Preparing and presenting the manuscript  
A module manuscript consists of text, tables, figures and assessment question. It can also 
include videos and eModules. 

3.1 Text  
• Module written according to module briefing including references (see below) 
• Figure legends (including captions and credit lines, if necessary) 
• Table legends (including captions and credit lines, if necessary) 
• Cross-references (anchors) in the text to all figures and tables  
 

Formal preparation: 

• Word processing software: Microsoft Word. 
• Arial, font size 11pt, 1.5 line spacing, normal margins. 
• Mark single words in bold to emphasize their meaning. 
• Use italics only for names of species (eg, Staphylococcus aureus) 
• Mark the structure of the text by indicating the hierarchy of headings/subheadings using 

a different font size or color from the main text. 
• Anchor all tables and figures in the text. Provide captions for every figure and table. 

 
Terminology and style 
In editing the manuscripts, the editors will follow the general style outlined in The American 
Medical Association Manual of Style 9th edition, the Chicago Manual of Style 15th edition, and for 
medical terms the Stedman’s Medical Dictionary 27th edition. 
 

Some points of style: 
• Use the current SI units of measure. 
• Avoid footnotes. 
• Use the international anatomical terminology of the Federative Committee of Anatomical 

Terminology, as a reference for the correct name of an anatomical structure. 

3.2 Tables 
Enumerations and flow charts are not tables. A table should have a good didactic structure. 
There should be no empty cells in a table (for no content insert “——“ or “0”. Give each table a 
legend. Number tables independently from figures, eg, Table 4.3-1. Give an anchor (=cross 
reference) in the text for each table, eg, (Table 4.3-1). 

3.3 Figures 
Illustrations or sketches of illustrations (eg, flow-chart), photos, x-rays (film or digital), CT scans, 
MRIs, and any labeling within such a figure. 

Computer-generated art may be submitted, although the submission of electronic files can entail 
printing problems. Please try to replace electronic figures of questionable quality at the 
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beginning or submit original glossy prints, slides, or original artwork that can be reproduced well 
at AO Education, Publishing.  

Note: Figure files submitted in PowerPoint, Word, Excel, Corel Draw, etc, can often not be used 
(resolution not high enough for print).  
Electronic photographs: Save electronic x-rays, CTs, etc, as TIFF or JPG files at a resolution 
of at least 300 dpi (dots per inch) and a width/height that matches the desired publication size in 
the AO Faculty Compendium. Please see chapter 7 "Check image resolution" for specific 
information. 

Labeling: The typesetter will label figures, so please submit an unlabeled (high-resolution) file of 
the figure as well as an exact sample of how to label this figure (on paper or in an additional file). 
The typesetter is not a doctor and needs a correct sample in order to correctly label an image. 
Sketches: Hand drawings for illustrations need to be clear and show colors (eg, red for arteries, 
yellow for nerves, etc). Number all drawings correctly, according to the text, anchors, and 
legends. Write any comment/description that helps the nonmedical illustrators to interpret 
drawings correctly on the draft. The illustrators understand correct anatomical structures, if 
correctly named, but they are not surgeons and therefore don’t know medical procedures, etc. 
Use correct denominations of instruments (eg, current Synthes catalog) depicted in such a figure 
and give the illustrators a separate photo, etc, of the instrument, if necessary. Differentiate labels 
(for print) from illustrator instructions. 

3.4 Assessment-Questions 
Assessment questions are the core and centerpiece of medical education processes. They build 
the basis of all interactive learning activities. The assessment fulfills a number of important 
goals: 

• Motivates learners to self-assess and engage in self-directed learning 
• Identifies to learners areas that need further attention 
• Contributes to achieving curricular objectives 

All assessment questions in most of the programs should be based on learning objectives 
defined by the project teams. All learning objectives are assigned to one of the three defined 
levels of knowledge (basic, intermediate, complex).  

For every learning outcome at least one assessment question will be required. For learning 
objectives of high importance, several different assessment questions should be prepared. If a 
learning outcome is assigned to more than one level, test questions need to be written for each 
level.  

General specifications of test questions: 
• Test questions contain four answer options, one of which is the single correct / best 

answer and three that are plausible but incorrect.  
• The feedback rationale explains the correct and the incorrect answer options.  
• Each rationale is referenced (consider your references when writing) or contains 

information for further reading.  
• Images (x-rays, MRIs, photos, other clinical material) can be included when they clarify 

the question or if they need to be interpreted to answer the question. 
• Bias is avoided. 
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For more detailed instructions on how to write assessment questions consult Appendix A "Self-
assessment test question writing". 

3.5 Videos 
Videos are audiovisual media that can convey content in a different way as it provides a sensory 
experience in comparison to written text and can enhance comprehension of complex concepts. 
If you would like to create a new video for your assigned module please consult your editor. If 
he/she agrees please contact the project coordinator for detailed instructions. 

3.6 eModules 
eModules are aimed at online learning from a distance. The learner can access them 24/7 and 
at their own pace. These modules can include videos, images, and texts. The interactive video 
as a teaching method has been very successful, especially in the fields of health and safety, 
where it has significantly helped in terms of error-prevention. If you would like to create a new 
eModule for your assigned module please consult your editor. If he/she agrees please contact 
the project coordinator for detailed instructions. 

3.7 Letters of copyright permission 
Contributors are required to secure permission for the reproduction of any figure, table, or 
extensive (more than fifty words) extract from the text of a source that is copyrighted or owned 
by a party other than AO Foundation or the contributor. This applies to direct reproduction as 
well as ‘derivative reproduction’, where the contributor has created a figure or table which is very 
similar to a copyrighted source. 
 

In general: Please refrain from taking figures/tables/text from preexisting works. If you 
nevertheless want to use such material, ask for permission first and, if obtained from the 
copyright owner, give the complete source/credit line in the manuscript (in the 
corresponding caption or paragraph). 
Note that AO Education usually does not have a budget for the usage of preexisting works. Do 
not submit manuscripts where a copyright permission is pending; they are not ready for 
submission.  

Any figure, table, artwork, or long quote (more than 50 words) that has been previously 
published requires written and originally signed permission of the copyright owner as well as a 
complete credit line. 

When using preexisting figures that have not been created by the author of a module, it is 
necessary to request copyright permission. The copyright owner may be the publisher, 
photographer, illustrator, or author. In most cases, the publisher will know who owns the 
copyright and therefore needs to be addressed. 

Photographs showing people in a way that they are recognizable in their personal 
environment/context require additional written and signed permission by that person (see 
below).  
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If a figure, table, artwork, or quoted text needed permission and a credit line in a previous 
edition, permission must be requested for subsequent editions (including electronic versions). 

It is the authors’ responsibility to procure all letters of permission. Please submit the 
original letters to the editor together with the manuscript.  
A template both for requesting copyright permission and a declaration of patient consent 
is attached below or can be downloaded from 
http://www.aopublishing.com/authors/authors.htm  
Please see Appendix B "Copyright permission" for the document. 

3.8 Submitting manuscripts:  
• Only submit complete and finalized manuscripts. If, for example, copyright permission is 

pending, the manuscript is not ready.  
• One Word file for the text, separate files for each figure (correctly labeled/numbered for 

placement). Color-scan all sketches of figures.  
• Filename: Indicate the project (AOF_FC), the module title, the date of last editing and 

the initials of the last author/editor.  
Example: AOF_FC_Lecturer_20110428_MT.doc 

• Naming figure/image files: Indicate the AO Faculty Compendium, the module title, and 
figure number that matches the one in the text. Add "REF", if the file serves only as a 
template for correct labeling of the respective figure. 
Example: AOF_FC_Lecturer_10a.jpg (figure 10a in the lecturer module) 
Example: AOF_FC_Lecturer_10a_REF.jpg 

 

   

http://www.aopublishing.com/authors/authors.htm
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4. References and bibliography 
References are sources of information the text refers to or quotes from. The text needs to 
contain a cross-reference for each reference, eg, [1] as a cross-reference to reference 1, etc. 
Only use publications that have been published. 
 
The AO bibliographic style is adapted from the “National Library of Medicine 
Recommended Formats for Bibliographic Citation” 
(http://www.ncbi.nlm.nih.gov/books/NBK7282/#A32370). 
 
Our adaptations: 
 Number of author names is reduced to three; if more 

authors were involved the term “et al” is used. 
 The n-dash is used to indicate the range of pages. 
 The page numbers are written out completely (eg, 187‒192). 

 

4.1 Journal article 
Volgas D, DeVries JG, Stannard JP. Short-term financial outcomes of pilon fractures. J Foot 
Ankle Surg. 2010 Jan-Feb;49(1):47‒51. 
 
Petitti DB Jr, Crooks VC, Buckwalter JG, et al. Blood pressure levels before dementia. Arch 
Neurol. 2005 Jan;62(1):112‒116. 
 
Parkinson Study Group. A randomized placebo-controlled trial of rasagiline in levodopa-treated 
patients with Parkinson disease and motor fluctuations: the PRESTO study. Arch Neurol. 2005 
Feb;62(2):241‒248. 
 
National Institutes of Health (US). End-of-life care. National Institutes of Health statement on 
the state of the science. AWHONN Lifelines. 2005 Feb-Mar;9(1):15‒22. 

4.2 Non-English journal article 
Calera Rubio AA, Roel Valdes JM, Casal Lareo A, et al. Riesgo quimico laboral: elementos 
para un diagnostico en Espana [Occupational chemical risk: elements for a diagnostic in Spain]. 
Rev Esp Salud Publica. 2005 Mar-Apr;79(2):283‒295. Spanish. 

4.3 Journal supplement 
Draghici S, Khatri P, Shah A, et al. Assessing the functional bias of commercial microarrays 
using the onto-compare database. Biotechniques. 2003 Mar;Suppl:55‒61. 
 
 
 

http://www.ncbi.nlm.nih.gov/books/NBK7282/#A32370
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4.4 Forthcoming article (in press) 
Forthcoming material consists of journal articles or books accepted for publication but not yet 
published. "Forthcoming" has replaced the former "in press" because changes in the publishing 
industry make the latter term obsolete. 
 
Laking G, Lord J, Fischer A. The economics of diagnosis. Health Econ. Forthcoming 2006. 

4.5 Book 
Iverson C, Flanagin A, Fontanarosa PB, et al. American Medical Association manual of style. 
9th ed. Baltimore: Williams & Wilkins; 1998.  

4.6 Book module 
Rojko JL, Hardy WD Jr. Feline leukemia virus and other retroviruses. In: Sherding RG, editor. 
The cat: diseases and clinical management. New York: Churchill Livingstone; 1989. p. 229‒332. 
 
References should always be checked and verified. 
Use www.pubmed.org for verification. 
For guidelines for citing material on the internet, see 
http://www.ncbi.nlm.nih.gov/books/NBK7277/ 
 
  

http://www.pubmed.org/
http://www.ncbi.nlm.nih.gov/books/NBK7277/
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5. Using Track Changes in Microsoft Word 
Microsoft Word has built-in tools to help you revise documents. This tool is called "Track 
Changes" It operates on the principle; that is, it allows you to make changes without changing 
the original document 

5.1 Microsoft Word 2003 or older 

There are several ways to initiate Track Changes. The easiest is to open a sample document 
and right click on the grey box labeled TRK at the bottom of the page.  

                      

After right-clicking, choose Track Changes. You have now initiated the Track Changes feature.  
Another way to turn on Track Changes: On the Tools menu, click Track Changes. 

You'll see that a new toolbar, called the Reviewing toolbar, has appeared at the top of the 
document: 

 

Note the highlighted button that is second from the right. As long as this button is highlighted or 
TRK is black, all changes will be displayed in the Track Changes view. 

5.2 Microsoft Word 2010 

In Microsoft Word 2010 you will find Track Changes in the Review tab (see tab highlighted in 
yellow below). 
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5.3 Accepting or rejecting changes 

If someone made changes to your document, Track Changes will appear on your computer 
when you open the document. The print version looks just like the screen version, with the 
vertical lines on the left and the boxes on the right with the changed information. To get rid of the 
markup notes, you must first reject or accept the changes. To do this, look at the Reviewing 
toolbar: 

 

 

 

The buttons to the left of the Accept Change button allow you to navigate to particular changes. 
If one of your peers made the changes to your document in Track Changes, click on the change 
and evaluate whether you agree with the suggestion or not. If you agree, then click Accept 
Change. If you do not agree, click Reject Change. Choosing either option will remove the Track 
Changes formatting, and the change will be permanently incorporated into your document or 
permanently removed. 

Note the drop down box on the left side of the reviewing toolbar. Your options in this box are:  
Final Showing Markup, Final, Original Showing Markup, and Original.  

You can change the way you view the original document and the changes that you or your 
reviewer made to the document. For example, if you made changes to the document but don’t 
want to display them, you can switch the view from Final Showing Markup to Final before 
sending the document out. Changing the view allows you or your reader to see the document 
with the changes made and independent of any Track Changes formatting, but the changes are 
not yet permanent. To make them permanent, you need to accept or reject them.  

  

Accept Changes 

Reject Changes 
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6. Sharing files and submitting final resources ("Google Drive") 
If you want to share a document with your author colleagues, edit the working documents for 
your module or submit a final resource please use the document sharing tool Google Drive. 
To use Google Drive you need to have a Google Account. If you do not yet have one please 
follow these steps to create one: 
 
1) Open your internet browser (Internet Explorer, Firefox, Google Chrome, or Safari) and type 

https://accounts.google.com/ in the address bar. Press enter.  
2) The login-window will open up. If you do not yet have a Google Account, please choose 

"Create account" (see print screen). 

 

  

https://accounts.google.com/
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3) In the application form click on "I prefer to use my current email address" and enter the 
email address you use for your communication with the AO (if you want to use a different 
email address or create a new one please send this address to the project coordinator so 
he/she can share the working documents with this address). Fill out the rest of the form and 
click on "Next step"  
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4) You now need to verify your email address. The easiest way to do this is if you click on 
"Request a verification email". You will then receive an email to your current email address 
containing a link to verify it. Click on the link. 

 
5) Once your email address is verified, you can sign in under the same link: 

https://accounts.google.com/ 
6) You will receive an email containing a link to the project folder for your specific module. 

Please click on the link to login and view the folders and documents. 
7) Now you can edit the working documents in the "Working Documents" folder or upload new 

files to the "Final Documents" folder. 

  

https://accounts.google.com/
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7. Check image resolution 
Before submitting images that will be published it is very important that you check their quality. If 
image quality does not meet the standards for print production, we will request from you a better 
quality image.  

7.1 Irfanview 
IrfanView is a very fast, small, compact and innovative freeware graphic viewer for Windows. 
 
How to install IrfanView? 

• Download IrfanView from www.irfanview.com. 
• Click on the downloaded file to start the setup of IrfanView.  

 

 
 

• Go through the installation process by clicking "Next".  
• Deselect the Google Toolbar unless you would like to have it installed. 
 

 
 

• Continue with Next until you have successfully installed Irfanview. 
 

http://www.irfanview.com/
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Check the resolution and size of images in IrfanView 
• Open IrfanView 
• Open an image in IrfanView (File -> Open) 
• Check the image properties (Image -> Information) 

 

 
 

• You will be presented with new window detailing the image information. The window 
might look something like this: 

 

 
 

• Please note the print size for this picture is 19.0 x 14.4 cm. The resolution though is 72 
DPI which is unusable for print 

• Change the resolution setting to 300 DPI by entering 300 into the 2 resolution fields 
followed by clicking on the Change button. 

• Notice now that the print size has changed to 4.6 x 3.5 cm 
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• For most uses this size will be too small and the image or illustration therefore unusable 
for print. 

7.2 Photoshop 
Check the resolution and size of images in Photoshop 

• Open Adobe Photoshop 
• Open the figure file 
• Choose Menu Image  Image size 
• Tick "constrain proportions"  
• "Resample image" must not be activated 
• Insert 300 dots/pixels per inch of resolution 
• You will get the maximum size of the image in cm or inches. The width and height of the 

image changes 
• Be careful to check if it’s cm or inches 
• Decide if we can publish it or if you need to find a new picture—under 300dpi won't work 
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A. Self-assessment test question writing 
How to select the content of a test question 

• Focus on the most critical knowledge: Ensure that the knowledge tested is linked to one 
of the defined learning objectives for the project. Focus on core knowledge: What are the 
most important aspects within a learning outcome? 

• When writing test questions, identify what should be tested:  
a) Recall of basic facts. 
b) Interpretation of medical data. 
c) Clinical problem solving. 

 
• Ask questions with an answer that relies on agreed–upon standards of practice or 

evidence from the literature. 
Include references to literature used in drafting the content of the topic. Include 
recommended readings with a view to enhancing the residents' knowledge of the subject 
matter. 

• Adjust the questions to the levels of learners: Remember the defined levels: basic, 
intermediate, and complex contents. 

 
How to write the question 

• Be clear, concise, and use simple language: The reader must be able to understand the 
question and answer it without seeing the response options. Questions must be easy to 
understand, especially for nonnative English speakers.  

• Ensure that each question consists of only one question. 
For example, do not ask about a diagnosis and the treatment in one question. 

• Do not use negatives: Avoid negative questions like “Which of the following statements is 
NOT….?”  

• Provide all visual information required to promote understanding of the issue. 
• Charts, drawings, pictures, and web links. Please deliver images with the highest 

available resolution (Dicom, JPG, TIFF, PNG, BMP, GIF). 
 
 
How to write the 4 answer options 

• Use your experience to list typical errors: Consider typical errors or frequent 
misconceptions of residents that you observe in your practice. 

• Plausible and similar: Answer options must have similar content and phrasing that 
logically answer the question. The length of the answer options should be similar in all 
four options. 

• Make sure there is only one correct/or best answer. 
• Exclusiveness: Make response options are mutually exclusive. Avoid overlaps (eg, when 

indicating time ranges). 
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• Try to avoid standing out of the right answer: Keep all four response options to about the 
same length. 

• Terms not to use: "All/none of the above", "always", "never". (For experienced learners, 
these terms are often clues that an option is incorrect). 

 
How to write the rationale/feedback 

• Provide an explanation for the correct/best answer: Write one or two short sentences that 
describe why an answer is the correct or best answer. 

• Explain each incorrect option: Use short explanations for why options are incorrect. This 
makes the test question a valuable learning opportunity. You may have to write separate 
rationales for the incorrect answers. 

• Refer to images: If images are used, refer to them in the rationale: “Option A is correct 
because the MRI scan shows that…”. 

• Provide a reference/further reading in the rationale. 
 
Additional considerations 

• Abbreviations: spell out abbreviations. 
• Use standard units of measurement (cm and kg). 
• Use generic names for all drugs and orthopedic instruments/implants. 
• Copyright: If images have been published before, indicate the source of the image. 

 

Examples for phrasing test questions about medical content  

• Given certain clinical findings, what diagnostic procedures, tests, or imaging studies 
should be done first/next? 

• Given certain history and findings, what is the diagnosis/the best management? 
• Given certain patient characteristics or comorbidities (eg, obesity, geriatric patient, 

diabetes), how should treatment be varied (if at all)? 
• Given a certain progression of events, what is the next best intervention? 
• Given selected relevant information, what additional findings rule out/confirm a given 

diagnosis? 
• Given a certain finding, what pathology explains it? 
• Given certain circumstances, what can be done to prevent or treat a given complication? 
• Given certain patient circumstances, what outcome is predicted? 
• Given certain test results (x-rays, CT scans, photomicrographs, etc.), what is the 

appropriate interpretation/conclusion? 
• Given a certain treatment modality, what are its objectives/indications/contraindications/ 

complications criteria for evaluating success? 
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